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Getting Started

= Java Perspective
— Customizes the workbench for Java development
« Javarelated views, actions, wizards

= Java Projects

— Used for organizing your Java code

— Associated properties
« Compiler settings
« Javadoc location
- Validators
« Build path (same as classpath)

— Associated builders (compiler)
«  When you save changes to a Java source file the builder automatically compiles it
« Compiler is incremental so it only compiles your changes!

why “i"? it's simple.

Projects provide the highest level of grouping resources (source files,
graphics, executables, ...) in the workspace. Projects always have a type such
as Java, WebFacing, Web. Those projects that are not linked to a specific type
of development should use the "Simple" type. The project type specifies what
properties are associated with the project. For example Java projects have a
build path property where users can specify other projects and .jar files that
this project requires. Projects also have an associated builder which knows
how to build resources in the project (i.e. compile .java files into .class files.)
By default projects map to a subdirectory of the workspace directory on the
local file system with the same name as the project.



Web Perspective and Projects

= Customizes Workbench for Web development
— Java development is frequently done as part of a Web application
- Servlets

« Action classes (struts)
« Java business logic

= Web projects are also Java Projects
— Include same properties and actions as Java projects
— Plus properties and actions related to Web development
— Follows J2EE guidelines for file structure of a Web application

« All Java classes go under the Java Resources folder

« All Web resources (HTML pages, JSPs, graphics) go under the
WebContent folder

why “i"? it's simple.

Perspectives are used in the Workbench to provide coherent selection and
layout of views related to a specific type of development (Java, XML,
WebFacing, ...) By default the Java perspective shows the packages, outline,
hierarchy and tasks views. The Outline view is a standard Workbench view for
showing the outline of the resource currently opened in the editor. It works for
Java and other resource types like XML and SQL scripts. The Tasks view is
another standard workbench view and shows all errors, warnings and tasks in
the workspace not just Java errors. The packages and hierarchy views are
Java specific. Each of the four views are outlined in more detail on the
following slides.

-Packages view

«Shows only the Java projects in your workspace

«Collapses package directories into a single folder in the tree view
*Hierarchy view

«Inheritance hierarchy of the Java class
«Qutline view (standard workbench view)

High level view overview of the structure of your Java class
*Tasks view (standard workbench view)

«Shows compile errors and warnings
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why “i"? it's simple.

Here you see a screen shot of the Java perspective (default layout.) All open
perspectives are shown in the left hand column of the workbench window.
Simply click the perspectives icon to switch to the open perspective (this
applies to all perspectives not just the Java perspective.) Each perspective
typically contributes shortcuts to the workbench toolbar. The Java perspective

adds some icons for creating a new Java project, package. class, interface
and scrapbook page.
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Java Build Path
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why “i"? it's simple.

After completing the new Java Class wizard the .java file is created in the
workspace and the file is opened in the Java editor.



Content Assist —invoke by Ctrl + Space

= Suggesting class, method and field names
— Select class / method / field from list of suggestions
— Javadoc comments shown for selection
= Qverriding Methods
— Use code assist to display list of methods in super classes
— Select method from list to override in current class
= Adding import statements
— Invoke code assist after entering class name to automatically import the class

rry {

DriverManager .registexDriver(new AS400JDECDriver()):
Connection connection = DriwerManager getCon

[Attempts to establish @ connection to the given i B
} catch (SQLE=cerdatabase URL. The DriverManager attempts to O T R EETEEm =Rl T
T selext &n, appropriate driver From the set of @ gerConnection(String url, Properties infa) Connection - D

registered JDBC drivers. @ getConnection{String url, String user, String password) C
Parameters:
url 3 database url of the Form jdbe:
subprotacel:subriams
user the datahase user on whase behalf
the connection is being made

the user's passw

why “i"? it's simple.

Content assist provides a list of class names, interfaces, fields and methods
that are available in the current scope. To invoke content assist press Ctrl +
space (or right click and select content assist from the popup menu. The list of
options is subset by what you have already typed. For example: entering get
and then pressing Ctrl + space will show only methods starting with get. If you
keep typing then the list is further subset.

Tip: When using the workbench the user can double click on the title bar of
any editor or view to maximize the editor / view to take up the entire
workbench window.

10



More Content Assist — Methods and Variable Names

= Displaying parameters for methods
— Invoke content assist inside the method call’'s parameters
—  MyClass.myMethod(Ctrl+space

= Suggesting variable names

rry {

DriverManager registerDriver(new AS400JDBCDriver()):
Connection connection = DriverManager getConnection{'jdbc:as400: /- toraslfb’};

PreparedStatement

preparedstatement: - Preparedstatement

-§ catch (SQLException)|gatement - Preparedstatement

why “i"? it's simple.

Content assist will display parameters for methods and suggest variable
names.
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And More Content Assist - Javadoc

-
=
* Sample class to highlight the features of the

# <b>Java Developnent Tools<- in WebSphere Development Studio Client V5.0,
* Thi= class reads an 05-400 the results

Content assist for * o the comsois. NG

<> <jcode>

HTML inside * Bauthor yantzi S afin
Javadoc comments public class JDBECSample { | ° P%%

public static void main(

rry {

ZT]
*

% Sample class to highlight the features of the

% <b:lava Development Tools<~ in WebSphere Development Studio Client V5.0

% This class reads an 05400 physical file using JDEC and displays the results
* to the console

*

* @author yantzi
*

*
pub

@ avenm T Content assist for
o Javadoc comments

@ @serial
@ @serialData =1 {

—}tew AS400JDECDriver());
T anager gstConnection( " jdbs:as400: / torasifb');

why “i"? it's simple.

Content assist is also available for Javadoc comments inside the Java editor.
Content assist for Javadoc can provide suggestions for HTML tag names and
Javadoc keywords. Again the list will be subset by what is already typed.

@ @version




Quick Fixes

» The editor can suggest fixes when you have errors in your code
= To invoke “Quick Fixes”:
— Click on the light bulb in the left hand margin, or
— Press Ctrl + 1
= Editor lists suggestions along with a preview of the code if the fix is
applied

// Ohtain the session object from the servler request ohject
Httpiession session = regest.getdessionitrue)

 Change to request . X | Obtain the session object Fram the serviet request objec
@ Create lncal variable reqest HttpSession session = request.getSessionitrue);
o Creats field 'regest’
@ Change to 'Request’
@ Change to ‘Request’
© Create parameter ‘regest’
if (sessionBean != nul O Create lass ragest
O Create interface 'reqest’
I Obtain th

oo, b, samples . yourco

I Obtain the se
sessionbBean =
(com,. ibm. sawples. v

DBConnectionipecs connectionDBhean =
(DEConnectionSpec) session.getittribute("connectionYourCoDBhean®) :

hy “i*? it’s simple.



Templates

= Templates can be used to insert frequently used code patterns with
content assist, for example:

= Lots of templates are predefined for Java Tools
— lterate over an array using for loop
. for <ctrl + space>
— Inserting a try / catch block
« try <ctrl + space>
— Public, protected or private method
 public <ctrl + space>

= Define your own in the Java -> Templates preferences page
— Insert a customized Javadoc comment for your methods

why “i"? it’s simple.
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Crystal Enterprise hiame Cont - " —

Crystal Reports Designer =prex> javad: <pre></pre=
@author loc authar name Edit...

Crystal Reports Viewers

Data cast java dynamic cast —
HATS catch java catch black.
Help do java do while statement | |
InstalljUpdate else java else black. MI
Internet elseif java else if block
Series Projects false javadoc <code>false</code> MI
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+- Code Revier

iF java if stakement Export. ..
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the template is g rE—

selected [ptes !
. | Substitution variables
- Task Tags = . .
Type Filters |v Use code Formatter can be fl"ed n
el Etor A reswzoa @Utomagically or by
h the user
Impart... Expart... l_o T

why “i"? it's simple



& Opan Typs =13
Navigating Through Your Code e —
e ;
= There are lots of different ways to quickly navigate through S?ﬁ:
your Java classes, here are some tips: O Ry
— To open aclass §%m
« Use the “Open Type” Dialog S — ol
— Shortcut: Ctrl + Shift + T o e
 Select the class name in the editor and press F3
— Use the pop-up outline view in the editor . .
« Shortcut: Ctrl+ O

— Use the navigation aids in the icon bar
» Go to last edit location
» Back to last location, forward to next location
« Go to next problem, previous problem

i
\ | 'd_’

[F-0-a-18s ] 4B)l8-5 -wc-= -]

why “i"? it's simple.



Javadoc — Easiest Way to Document Your Code

= Java Documentation

— Standard way of documenting Java code that automatically generates
HTML documentation for your classes

— You insert Javadoc comments for your class, public constants and
methods then run the class through the javadoc utility

— Comments can include HTML markup and specialized Javadoc
keywords

= Generating Documentation
— Select the Project > Generate Javadoc... menu

— Customize javadoc generation options

= Viewing Documentation

— Select your project in the Workbench and select Navigate > Open
External Javadoc

« or
— Use Javadoc view in the workbench

why “i"? it’s simple.
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Exporting Javadoc

@ Generate Javadoc © Generate Javadoc

Javadoc Generation

Select bypes For Javador generation, @ N

Javadoc Generation

Configure Jawadoc arguments for standard doclet.

Javadoc command:

| Ciiprogram Fiies\terJaval42ibinyjavadoc exe | | configure... |
Select types for which Javadoc wil be generated:

OE® 15PandservietExample

‘O Sample iSeries Java Source

=Y Sample Java Source

Create Javadoc for members with visibility;
© Private " Package " Pratected & Public
Public: Generate Javadot For public classes and merabers,
% Use Standard Doclet
Destination: | CiiDocuments and Settings\yantzl TOROLABYEMrationak  Browse...
" Use Custor Daclet

Doclet name: |

Doclet class path; [

< Back Next > b - -

I™ Dacument ttle:

Basic Options ——————— -Document thesetags ———————
|V Generate use page v @author

W Generate hierarchy tree W @wersion

W Generate navigator bar W @deprecated

|V Generate index |V deprecated list

¥ Separate index per letter

Select referenced archives and projects to which links should be generated:

0 ank.jar - not configured A Select Al
[ anksupport jar - nat configured
O (7 charsets. jar - httpijfiava.sun.comfizss/1.4.2/docs/api
) compatibility jar - not configured
) configurator.jar - not configured
47 consale.jar - not configured

(7 core.jar - httpiffjava.sun.comjjZsef1. 4. 2/docsjapi
. core. jar - nat configured

Clear Al

ik

Configure

E3

I~ style sheet: | Brovse, .

i

b 1 1

<gack | Mewr [[Fmsh | conal |

why “i"? it’s simple.
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8&EVIEt.http. HttpServies

Al Classes com. ibm, samples, yourco. employes  InseetPreferences

Fackages All Implemented Interfaces:

£ombm samplesyon_ | Java o Senakeable, javae serviet Serviet, javis serviet ServietConfig

COM DM SAMRIEs you .

COM DM SaMRIEs you Javadoc dlSpIayed
COM DM SaMRIEs you

pubke class InsertPreferences i
P in Web browser
i i 5
B She A
B Senshzed Form
Eytiame
B
Cooter Constructor Summary

CreateCintanasefiear
CrHWDanSES&n" InsertPreferences ()
ExpirnghIMLSErAE

tm Problems Declaration ‘ Conso\e|Progress ‘ Properties|Tasks| | =8
P,;,LW#F lawador - java,util. vector

Ssheg,

U The vector class implerments a growable array of objects. Like an array, it containg components that can be
Sy accessed using an integer index. However, the size of a Vector can grow or shrink as needed to =

S|l accommodate adding and remaving items after the Veerar has been created.

Each vector tries to optimize storage management by maintaining a capacity

2 B .
Ww The capacity is always at Ielast as large as the vector size; it is usually larger JaVadOC dISpIayed
added to the vector, the vector's storage increases in chunks the size of capac i

il can increase the capacity of a vector before insering a large number of compone in Workbench VieW

of incremental reallocation.
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Java Visual Editor

-
E SimipleT:

B

= Simple Text Editor

Graphical pane

Use properties
view to change
attributes of
graphical
components

Select parts from
the palette and
drop them on
the window

—
I‘ | Loau Fie ||mSaveFiIE || it |

[

|

—Palette — 3

[ Selection

pa)
L4 Marquee

s Choose Bean
| 15eries Uitiities Ed

S
. ISerieslistRecords

H JFormattedComboBox
2 JFormattedL abel

[ FormattedTable

f TFormattedTableColumn
(1 JFormattedTextField

[ ListManager

i RecordIoManager

= iseries Toolbox Access

= iseries Toolbox Visual

[=> iSeries Toolbax Security

[=> iSeries Toolbax HTML

Source pane

[

£ = ‘A - 2 [ I5eties Toolbox Serviet
¥ ) [ Swing Companents
=]
(= Swing Containers
- i t id
pxvatelyon) { . (= Swing Menus
int state getJFileChooser () .showSaveDialog(this)
if (state == JFileChooser.APPROVE OPTION) | = AWT Controls
File £ = getJFileChooser().getSelentedFileii: (= Data Sources
try { (= Data Objects

= Swing Binders

21



Agenda

Getting Started

The Java Editor

= Visual Editor

E> » Java Views

Compile / Run / Debug

= jSeries Additions

= Reference

why “i"? it's simple.

22



Package Explorer

Higrarchy =8
| Bls v
. . =-1E2 15PandservietExample let Working 5ol
= Central location for managing your g 5 devssourcs e
= 3 com.ibm.samples.controller
Java resources 5 ) Conroler.va
—Shows only Java related projects o Emﬁffmf:fmf;':;;?u:m v Non-Java projects

- com.ibm.samples.database

_Web projeCtS are alSO ‘Java projeCtS =-F3 comiibm.samples,exphtmiserviet Layout 3
-3 com.ibm.samples.form
. - com. b, samples. select “5. Link With Editor
= Use Working Sets to show only a + gmm“bm.samﬁ\es.s.mp\e 3
subset of all Java projects o o B o bomsamlossurvey

#- () dbbeans.jar
-4 RE_LIE - C:\Program Files|IBM|Rationali50

» Displays external jar files included in 4 B TRE System Librory [WebSphere +5.1 ]
H ) H #-m WebSphere v5.1 Runkime
the project’s build path e
—Can be turned off with filters o4 eiimn ey
#-E3 jve.generated
. . ¥ ® JRE System Library [edlipse]
= Use filters to control what is shown -5 iseres Ltites and Tookbox
. . #-m Standard Widget Toalkit (SWT)
in the packages view 552 Sample Java Sourse
< b

why “i"? it's simple.

Packages are shown as their corresponding folders (com / ibm / etools /
iseries / ...) which takes up a lot of the room in the tree view. The Packages
view addresses both of these issues by showing only Java projects (and those
projects which have a Java nature like Web projects) and showing Java
packages as a single entry in the tree view. The Packages view also lets you
see any referenced libraries directly in the tree view. Reference libraries are
setup in the properties for the Java project and are covered later in this
presentation.
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Refactoring allows you to easily
rename or move a method and the tool

Outllne VleW automatically finds and updates all
e x references
_ , Fw % o % v
u WOI‘kS n COnCert Wlth the Java £ org.eclipse.care.internal resources -~
. #- = import declarations
Edltor =@ WU;"SD“EE ) Open Type Hierardhy F4
g 3 c:ear(CF:(lej (Fie) Open Call Hierarel Chel+alk+H
. . dearChildren(File
= Shows imports, fields, methods o defaultWarkepaceDesciption) of- Cut e
. & ¥ isDuplicate{Object[], int) =
—Can subset what is shown o © viorkspacel) = copy amic
< aboutToBuld() [ Paste Chel+y
—Can sort by name o EEUSEEENIEEEE x ouss .
@ . addResourceChangelistaner
© . sddResourcaChangelistenerl  20U1C® '
= Can show only selected member 8- shSerrncpnpish I Eee '
H B (-] eginOperation(boolzan,
in editor  broadcastchanges(it, bode| :
<> broadcastEvent(LifecycleEvel BRI '
@ .. buildfint, IProgressMonitor) Orourrences in File
» Generate getter and setter © - checkpot{zoolan) Tocgle Wethod Sreskpoint
H @ close(IProgressMonitar)
methOdS for flelds =l @ computeFullProjectrdey Run :
=@ new Comparator(f{. } DEb‘_"g
@ . compare{Qhiect, ¢ Profile L
* Generate Javadoc comments s computePrerequisiflordan(le]  Compare With v
EaD: dar(l  Replace With L4
ec Restore from Local Histary. ..
Shortcut for menu ||  Enterprise Bean 3
options for searching Vaualee v

Component Test 3

why “i"? it's simple.

The Outline view shows the structure of the Java class currently being edited.
It's main function is to provide you with a high level view of the structure of the
class and provide easy navigation in the editor. Selecting a method / inner
class in the outline view automatically positions the editor to the corresponding
source code. The Outline view also provides many additional actions. These
are available when you right click on the different items (classes, methods,
fields) in the Outline view. For example: Right click on a field in the Outline
view to see the option to generate standard getter and setter methods for the
field. To remove a method right click on the method in the Outline view and
select "Delete". The method and its corresponding code are deleted from the
editor. The Outline view also provides some additional functionality such as:

«Toggling showing fields on / off
*Toggling showing static methods on / off
«Sorting the list of fields / methods

«Showing only the selected field or method in the editor instead of the entire
class file
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Hierarchy View
Package Explarer =8
Hierarchy : Yectar kt: :LT; T]! léEJ p—
=& Object ~
= (3" AbstractCollection B
H 7 = @* AbstractList
Hierarchy view =9 q | |+ Shows selected
ShOW_S a Cla_SS @ AttributeNameEnumeratic members in hierarchy
relat|ve to |tS gF Q:trihuteNameEnumerat\c at a” |OCatiOnS Where
superclass and ©F Generaanes - they are declared.
subclasses. < g
9 veatr |8 1% N ell 1o Show/ hide inherited
o, 41| members
< elementCount
¢ elementData ; ;
To open a class in the | |©:=0 Show / hide fields
p. N | ez\fector(\nt) b
hierarchy view Serminn - Show/ hide static
highlight the class © s acin, Object) members
name in any source | | & cotcin , ,
f||e or Vlew and preSS @ g addaliCollzction) . Show / hide nonpub"c
@ gaddElement{Object)
F4. o s—— members
© aclaar()
@ g clonel)
@ . contains{Object] s

why “i"? it's simple.

Here you see the Hierarchy view with descriptions for the various features of
the view. The first option (show selected members in hierarchy) lets you select
a member from the list at the bottom of the view and the tree view at the top
will be updated to show which classes have defined this method. This allows
you to quickly see where the method has been overridden.

25



! Problems view shows
Problems and Tasks Views build errors and warnings

in source code

Jawvadoc | Declarstion | Properties | Tasks x :=::> ~ =0

Error ® (R X N
1 errar, 26 warnings, 0 infos
| Description ‘ Resource | In Folder ~

@ The method geParameter(String) is undefined for the ky,.,  Controller.java JSPandServ?plefJavaSourc

& The method getUniqueldentifier() From the type TPluginD...  BuildManager.java Sarnple Java Soyfce/srcforgfedips—
& The method getDeclatingPluginDescriptor() from the typ..,  BuildManaget.java Sample Java Sglrce/srcforg/edips

Warnings ®\

& The type PluginDescriptor is deprecated EventStats java Sample Java Fource/srcjorgfecips

& The type IFluginDescriptor is deprecated EventStats,java Sarnple Ja\fuurce;’src;‘org;‘echps

& The type IPluginDescriptar is deprecated Eventatats isva ample 12 Source/sreforgledips

& The type IPluginDescriptor is deprecated Evd ‘srcforgfeclips:

< Filter problems >
and tasks

& X v =0

Resou rce Problems | Javadoc | Declaration | Praperties &= [ERT

60 items

Specific task N | | Description | Resource | 1n Folder Location_ 4
And elseif condition Controllerjava JSPandServistExample/lavaSource/com,.,  line 60
Ja i1 I

|:| Extract method inta superclass Controller.java J5PandServietE:

Ly Pickup milk on the way home
/

General task

User defined and
program detected tasks

why “i"? it's simple.

The Tasks view is a standard workbench view showing all errors, warnings
and user defined tasks in the workspace. Because it shows all workspace
tasks it provides filtering capabilities to scope what is shown in the actual view
by the type of problem / task or based on what is selected in the Navigator
view or Packages view.




Agenda

Getting Started

The Java Editor
= Visual Editor
= Java Views

Compile / Run / Debug

N

= jSeries Additions

= Reference

why “i"? it’s simple.
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Compiling your Java class

= Every time you save your file it is automatically compiled (this is
called building in the Workbench)

= Or you can force a recompile
— Select project in package explorer, then select either
« Project > Clean...

© Java - IBM Rational Software Development Platform
Fle Edit Source Refactor Navigate Search US98 Run Window Help

i © e s-0-4

=0
-

Close Project

Hierarchy

on
Bk
Build Working Set
Clean. ..

Build Automaticaly

=3 jve.generated
- JRE System Library [eclipse] A

Generate Javadoc with Diagra

H enerate Javadoc... ?
Turns off automatic Senerste 2ved w3 fram scrate,

Propertiss " Clean all projects

Clean will discard all build problems and built states. The projects will be rebuilt

builds ... use
. | & Clean selected projects: ‘ Sample iSeties Java Source Brawse. ..
cautiously!

r

s Siipie.

When you save a Java class (.java file) it is automatically compiled and all

errors / warnings are shown in the tasks view. However you

can also force a

recompile using either the build or rebuild project actions. The Build Project
action is an incremental build that builds only resources that have changed

since the last build. The Rebuild Project is a full build that di
previous build stat and rebuilds everything.

scards the
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Running your Java Application

= Standalone Java application
— Class implements “public static void main” method

— Run locally, or
— Run remotely on the iSeries

= Servlet (Web Application)
— Class extends javax.servlet.http.HttpServlet

— Servlet can be run on different test environments and servers

why “i"? it's simple.

How you run a Java class will depend on what type of Java application it is. If
it is a standalone Java application (i.e. it contains a public static void
main(String[] args) method) then it can be run locally using either the JDK
shipped with the workbench (this is the default) or any JDK installed on the
local workstation. You can specify which JDK to use in the Java project
properties. You can also run the standalone Java application remotely using
iSeries extensions.

If the Java class is a servlet then it must be run in either the local WebSphere
Test Environment (default) or any other

application server environment supported by the workbench. Currently this
includes:

«Local WebSphere Test Environment
eLocal Tomcat Test Environment

«Local Tomcat Application Server
Remote WebSphere Application Server
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Running Standalone Java Applications

2. Select Run As -> Java Application

1. Select Java class in Package Explorer

© Java - uirEuEDGIIPIEE YG I MGG YY) Y E Y RIS

Fle Edt Source Refactor] Navigste Search FProject Run Window Help
F-0-9-G-/9 - OG- E H @ & &
51 R on servr

@ run... %) 2 Component Test

Oroaniec Ravortes s E{ 3 Hast Jawa Application

%8 4 iSeries Application in RSE Job
TAMPOrt I8 L g iseries Batch Application

5| B2 outine 52 =8
i~ R

ierarchy

5 com.ibm.iseries.samples
i
= import declarations
4~ com.ibm.as400,access, AS400IDBC Drive
A awa.sgl®
= (&, IDBCSample
88 mainiStringl])

ﬁ & iSeties Interactive Application
E’* 7 iSeties Mulki-threaded Application,

import cot

= H jve generated

4 E JRE System Library [ecipse]
-, iSeries Utiities and Toolbox

= =, Standard Widgst Toolkit (SWT)

8§ Java Applet

¥ 2 Java Application

J Java Application in iSetiefServer

Problems | Javadoc | Dedlaration Praperties | Tasks % RE L | B -=0

DECSample [Java Application] C:iProgram Files\IBM| R ational\SDPY6. 0\ecipseljrel bint javaw exe (Sep 14, 2005 11:36:01 AM)

000001 WEESPHERE REDEOOKE 30.00 3GZ4-5635 o

000002 Radio_Controlled Plane 96.86 DELUZE MODEL N |

000003 Change Machine 52.55 HAMDLES SEVERAL CURRENCIES

000004 Basshall Tickets 91.14 MIMLESOTIL TITIE

000005  Twelwe Mum Two_Pencils 50.58 ¥H . .

P —= = 3. Output shown in Console view

why “i"? it's simple.

Here you see how to run the standalone JDBCSample Java application used
through out this presentation. To run the application simply select the class in
the packages view and from the Run icon in the toolbar select Run -> Java
Application. If the application writes any output to either System.out or System
.err then the workbench console view will appear with the output. If the Java
class were a servlet then to run it in the local WTE you would select the class
from the packages view and select "Run on Server" from the popup menu.
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Running Java Servlets

& Server, Selection

Define a New Server

Chouse the bype of server to create. g

(& Enterprise Applications
[ Application Client Projects
(4 Connector Projects

(g EIB Projects
= & Dynamic Web Projects
=22 iSeries Weh Samples

- [@ web Site Navigation

%Gy Web Diagram
25 Deployment Descriptor: iSeries Web Sam
=€ Serviets

ol

New 3

Open

Open With 3

Import... 3
Y Export 3

= WebCon
+ (&2 15Pandservh

How do you want to select the server?
€ Choose an existing server
" manually define a server

Specify the host where you want to publish

Host name: | Iocakhost El
Select the server bype:
{4l wiebSphere v5 Server Attach
wiebSphere v5.,0 Server
{25 websphere v5.1 Server

wiebSphere v&.0 Server
#-[= Other

R

View By: |Vendor -

Description: Runs J2EE projects on the WabSphers v6.0 Server,

¥ 5et server as projact default (do not promp)

[#- 7 Other Projects Profile

(5 Web Services

-y Databases Propetties  Alt+Enter I I|
B

1. Right click on your

servlet and select
Run > Run on Server...

Select which type of
application server to
use for testing.

ceo | omexes [ Emsh | canea |
s simple

s
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Running Java Servlets
[J] 10BCSampleserviet. java | B
|:'vttp:f,ﬂocalhost:90BUfsamp\esiJDBCSamp\eServ\et LI B | v (O | ﬁ
~
000001 WEBSPHERE REDEOOE. 30,00 S5G24-5635 i
000002 Radio_Controlled_Plane 9686 DELUXE MODEL =
000003 Change_Machine 5255 HANDLES SEVERAL CURRENCIES
000004 Baseball_Tickets 9114 MINNESOTA TWINS } |
000005 Twelre_Mum_Two_Pencils 5058 YELLOW INN COLOR
000006 Over_Under_Shotgun 79.66 12 GUAGE
000007 Feel_Good_ Vitaming 2981 ABCANDD
000008 Cross_Country_Ski_Set 93.00 ENTEY LEVEL
000009 Rubber Baby Bugzy Wheel 9871 4 INCH SIZE
000010 ITSO REDBOOK $G24-2152 50.00 ACCESSING THE AS/400 WITH JAVA
BUILDING AS/M400 APPLICATIONS
000011 ITSO REDBOOK 5G24-2163 2087 ottt
000012 Plastic_Garbage_Pail 2240 36 GALLON CAPACITY
000013 Doll_House_Fumniture 2422 EITCHEN ONLY
000014 Plain_Pockets_Pants 10.28 SEVERAL COLORS AVATLABLE
000015 25 Inch Color TVs 63275 BUILT-IN VCR
000016 Multi-System_Paper 7157 STANDARD US SIZE
000017 Magical Mystery_Maze 3583 FOR BEGINNEES Output from servlet
LT appears in embedded
web browser

hy “i*? it’s simple.




Debug
Launch the debugger the

same way you run the Java

File Edit Source REfa(tD.r Mawigate Search Project Run  Window Help program
Irs- |8 |8 |$-0-9-Q-|9- |

[ & -5 - - "1Web5phere 8.0 Server

Hierat 5 1RUn on Server I
|| % pebug.., gy 2 Component Test
= iSeries Web Samples Organize Favorites. . B2 3 Host Java Application

1E2 15PandServietExample TMpUTTye
= b" Sample iSeries Java Source
© F-ER com.ibm.iseries.samples A 5 5i5eries Batch Application
i BY DECSample. java * Sample

5 4 HTML Script Application

fn DBZ

& & iSeries Interactive Application

ﬁ
* @author | S 7iSeries Job

¢ R RE Systam Library [eckpes] N 3% 8 iSeries Multi-Threaded Applicatian
=i, (5eries Utilities and Toolbox wpublic cla:

[ 9 Java and Mixed Language Application
] Java Applet f

Tip: Set breakpoints in your source
code before launching the

Java Application

J Jawa Application in iSeries Server

debugger. 35 1ava ean ‘“;n:;
T W leik Blvsin Tack
You can set breakpoints in the Java I Opens debug perspective ...
editor by double clicking in the left >

hand margin of the editor.
why “i"? it's simple.

To debug the Java application select the class in the packages view and
select Debug -> Java Application from the Debug toolbar icon drop down
menu. It is a good idea to set breakpoints in your source code before
launching the application in debug mode. This will cause the debugger to stop
at the first breakpoint it hits in the application.




& Debug - JDBCSample. java - IBM Rational Software Development Platform Debug Perspect|ve
Fle Edit Source Refactor Mavigate Search Project Run Window Help
| #-0-%-%-(0- B AR Hi% 96§ &
FiDebug £ Servers =8 - Breakpoints X5« —0O
i 22 8% - 2 &
= AS400IDECC ki id=1%]
= com.ibm.iseries, samples. JDBCSample at lacalhost: 1614 A Sanection]t )
21 Thread [main] (Suspended) query= AS400IDBCStatement (id=22)
Ll et = results= A5400IDBCResutSet (id=94)
= IDECSample.mainiString(]) line: 26 m  catalog = "RCHASESC!
»® Thread [AwT-Shutdown] (Running) c\osedg: falen
@ Thread [AWT-Windows] (Running) 8 B 2
p® Thread [JavazD Disposer] (Running) a
»® Thread [AWT-EventQueus-0] (Running)
8 Thread AW T-Tnr FerhadMananer] fR1nnina' M
£ 4
[7) J0BCSample.java 57 8| BZ outine 2 =g
: Statement guery = connection.createStatementi): A laz W \\3 @ \\L -
# com.ibm.iseries.samples
if (query.execute ("SELECT * FROM WDSCDEMO. ITEM™) ) 5= import declarations
¢ = (3, JDBCSample
I3
Resultfet results = query.getResult3et(]:; of main(string[ 1}
while (results.next()}
{
System.out.print(results.gecitring ("IID™) ) 7
£ d
ElCansole 27 Tasks | iseries Commands Lag &l & | B-=8
JDBCSample [Java Application] C:\Program Files\IBMiRationalSOPY6. Meclipsetjreibinijavaw, exe (Sep 14, 2005 12;13:32 PM)
000001 WEEBSPHERE REDEQOE 30.00 SGZ4-5635
000002 Radio_Controlled Plane 96.86 DELUXE MODEL

Here you see the Debug perspective.



© Debug - JDBCSample. java - IBM Rational Software Development Platfo|

Debug Perspective File Edit Source Refactor Mavigate Search Project Run  ‘Window Help
miflhd H-0-9-%-0- &y =
Shortcut buttons for: T — =0
»Resume -
= IDBCSample [Java Applicalion, A
>Suspend =1-&® com.ibm.iseries samples.JDBCSample at localhost: 1614 |
>Stop = @ Thread [main] (Suspended)
. = I0BCSample.main(String(T) line: 26 =
»Step into / over / return |_—" & Thread [A4/T-Shutdown] (Running)
/ $® Thread [AwT-Windows] (Running) 2
Debug view shows: 4 >
»All running applications (D oacsanple ava 52
>Threads Statement guery = connection.createState

if (guery.execute ("SELECT * FROM UDSCDEN
{
ResultSet results = gquery.getResults

»Execution stack for suspended threads

while (results.nexci)]
{

Breakpoint
<
Elcansole 22 Tasks | iSeries Commands Lag

IDECSample [Java Application] C:\Program Files\IEM\RationaliSOPYG. Dleclipseljretbinjavam
000001 WEEBSPHERE REDEOOE 30.00 BGZ4-56!
000002 Radio_Controlled Flane 96.86 DELUXE 1

Console View ——

why “i"? it's simple.

The top view shown in the screen shot (Debug view) shows all applications
that are currently being debugged in a tree view. Below each application all
threads are shown, and for each suspended thread the corresponding stack
trace. The Debug view contains icons for resuming a suspended thread,
suspending a thread, stopping an application and for stepping into / over a line
of code or running to the end of a method. These options are also available
from the

Debug menu and have associated shortcut keys. Below the Debug view is the
source view where source files are opened if a breakpoint is hit.



Debug Perspective

RS RS SRR Hi% QGG

Mmessms Display | Threads and Monitars =8
T R

© Controlier [ine: 6] - performl s HEpSer et Reueet, HitpServstRasponss) *Variables View

.2 1peCsample [ine: 22] - main(Stringl 1)

@ Waorkspace [line: 207] - build(int, IProgressMonitar)

@ Workspace [line: 301] - close(IProgressManitor)

*Breakpoints View

1| Secune 2 - *Expressions View
bment () ; ~ laz};\\{ o W - p
5 com.ibm iseries.samples
10. ITEH") ) = “=  import declarations
= &, IDBCsample . .
pet () : q : © 5 main(String[]) ¢ Dlsplay View

v
2 eThreads and Monitors
% |l & | BE-=0
.exe (Sep 14, 2005 12:27:40 PM)

why “i"? it’s simple.

To the right of the Debug view is another pane showing the 4 views listed on
this slide. The two main views are the Breakpoints view (used for managing

breakpoints) and the variables view (used for viewing and changing the
contents of variables in the application).

Breakpoints View
Manage breakpoints in the workspace
Add Java exception breakpoints
Stop when a NullPointerException is thrown
This can be very handle in locating problems!
Inspector view
Detailed view for inspecting variables
Variables View
Shows all variables that are visible in the current stack frame
Display View

Displays result of executing an expression in context of current stack
frame

Highlight expression in editor and select "Display" from the popup menu
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Debugging Web Applications

Rew L3

= First start the application server in debug mode e

Delete

» Then it's the same as debugging standalone

Start

Java applications S Profic
— Set breakpoints inside your Java servlets or - zt;t '
JavaServer pages 51 Discornect
— Debugger stops when a break point is hit EP Pubteh
Monitoring 3
Restart Project 3

%, Add and remave projects...
Enable/Disable EGL Debugging

Run universal test clent

Restart universal test client

Properties | Quick Edit B Console‘Problems‘

Run administrative console

Server Hast name

Reconnect debug process
& [J Craate tables and data sources

| 2 Run external admin script

why “i"? it's simple.




| BMesenersees - IEH
Searching — Now Where Did That Go???

= Two main ways to search your Java code

1. Context sensitive searching
Most useful
Scope to workspace or class hierarchy
Packages / Classes / Interfaces / Variables / Members
Interfaces

2. Global workspace
Search the entire workspace
Simple file name searching

= Results are shown in the Search view

why “i"? it’s simple.

There are two main ways to search for "things" in the workspace. The first is
just a simple raw text search that will search for a string pattern in any type of
file.

The second is a "Java-aware" search that will let you search Java files for
strings that are context specific. Such as Declarations of all methods that start
with getA*

References to all methods that start with getA*
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Searching

Search remote iSeries

Simple text searching Java "aware" searching
source members

B Remote Search | B iSeries Search | E47 Fie Seerch | &7 Process Search | &7 dw Search | 37 Help Search 57 Java Search | %7 plugin Search |

Search string (* = any string, ? = any character):

|gat*evant* | ™ case senstive
i~ Search Far Lirik Tar

" Type @ Method (" Package @ Declarations " Implementaors

" Constructor ¢ Field " References Al Occurrences

€ Read Access £ Write Access
What to search for ¥ search the JRE system libraries

e ] Scope of search
& Workspace ¢ Selected Resources € Enclosing Prajects

© working Set: | - Choose. .. |

Tip: Use the actions from the searching

custonize. . shortcut actions from the outline view to cancel

avoid having to type this information

why “i"? it's simple.

Here you see the "Java-aware" search dialog. You use the radio buttons to
define the context of the search.



Agenda

Getting Started

The Java Editor

= Visual Editor

= Java Views

Compile / Run / Debug
E> = iSeries Additions

= Reference

why “i"? it's simple.
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Java Tools for iSeries

» Import and export from/to remote system
= Remote run and debug launch configurations

= Program Call Bean Wizard
— Generate Java code to invoke a *PGM or *SRVPGM

Toolbox for Java built-in

= Supplied Java-beans

why “i"? it's simple.

Here is an overview of those extensions. The following slides will look at each
one in more details.

«Export and import to/from IFS, through common remote system frame-work
support

«Special Java "compile" actoin/view for remotely compiling Java classes
«Special Java run action/view for remotely running Java applications
«Special Java debug action/view for remotely debugging Java applications
«Program Call wizard to "wrapper" any *PGM/*SRVPGM as a Java Bean
*Toolbox for Java built-in: integrated help and runnable samples

«Previously supplied Java beans: datafile updates/access (DFU beans), object
lists beans (PDM — library, object, member, field, record lists), and Swing GUI
beans (dspf-like function)
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Remote Import and Export

© Export
Select
Export resources to a remote fils system A
* Import files from a remote system
intO a IOcal prOjeCt Select an export destination:
il &
. . RgHATS Macro
= Export files from a local project to RgHost Publisher HOD Mecro
L 13AR file
a remote system Drevater
B Javadoc with Diagram Tags
f . f A & Leak Analysis
- Sl‘!pports IserIeS! Llnux’ Unlx’ Lé;ortarProrect Deploy Set
Windows Joprabe
D Froject Tnterchange
. . EIRAR file
= Uses the IFS on iSeries Tras asse
o
= Can also export to a JAR file on a Sdsymptom datsbase fle
A Team Project Set =
remote System ) UML2 Model
_ Useful for Java @uML Madel Template v

why “i"? it’s simple.

The workbench allows you to import and export your code (Java and non-Java
code) from/ to a variety of locations. To this list we added the ability to import
from and export to a remote system (iSeries or non-iSeries). Like all the other
import / export wizards, this ability is not restricted to Java only. On the iSeries
this wizard exports to and imports from the integrated filesystem (IFS).
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© Export ‘Z‘

Remote  [remtcnc e
E Export resources to a remote file system, r_\—l
Xport e

EIBJ RemoteSystemsConnections A~ forh IDBCSample. class

B DL?J Sample Jawa Source [1] JDBCSample.java .

= Clic sample iseries Java Sourcs ] fabsimpleTextEdtors1.lass Select files to
El O com \ [ % SimpleTextEditors 2. class export
E-E% wEn; [ fub SimpleTestEditors 3. class p
iseries [ fub SimpleTextEditor§4.class
O samples Ot simpleTextEditorgs. cl
B SimpleTextEditorss.clsss

1 O] iseries Weh Samples [ fub simpleTextEdar. class
O [J] simpleTextEdior java

DE? iSeries Web SamplesEAR 3

RSE Connectlon Select Types... Select Al Deselect Al

Qe AN T2 1. TORAS 1FB: |

Browse...

Options:

I Overwrite existing Files without warning
" Create directory structure For files

& Create only selected directories

I Save the settings of this export in the workspace (8.9, [ExportSettingsihello.rexpfd)

Description file: Erowse, ., |

cpack | weos [[Fnen | cancel |

why “i"? it's simple.

Here you see the next page of the export to remote file system wizard. Here
you specify which files to export from their workspace and to which remote
system and directory on that remote system. The import wizard has a similar
page.



| BMesenersees - IEH
Remote Run and Debug Launch Configuration

Use the other tabs to specify command line
arguments, JVM properties, environment
variables and library list

Create, manage, and run configurations

Create a configuration that will launch  remote

Configurations: Wame: | IDBCSample on iSeries
(3% Apache Tomcat -~
-3 Campiled Applicatior B
E‘ Component Test © Main I ©Q Run | il Properties I @ Environment | B Library List | ## Debug | ]
@{ Host C/C++ Applica
-8 Host Java Applicatio Profect:
L Hyades Manual Test -
£ Hyades LRL Test | sample iseries Java Source Browse. .
ﬁ iSeties: Run Applicat
Bk iseries: Run Batch & Main class:
B iseries: Run Inkeracl e
E‘i‘ iSeries: Run Multi-th |com.ibm‘iser\es.samples.JDBCSample Browse. ..
5] Java Applet I~ Include external jars when searching For a main class
_—[ vva Application n Include inhetited mains when searching For & main class .
< DACoanple (1) Specify RSE
T~ emote iSeries warking folder: COI’lneCtiOl’l and
“Ju Jnit YAMTZL, TORAS1FE: fhome YANTZI B ——
i JUnik Plug-in Test I |FS path for the
4@ Rurrtime Workbench [V Include working Folder in classpath .
E Test working folder
5] websphere v5.0 Ap v
< | = I
e | Delete | Apply. | Revert |
Same launch configuration can be used for run and debug.
Launch configurations are saved so you can quickly n | e |
. . I
re-run or debug the same application.

why “i"? it’s simple.




Remote Run and Debug on iSeries

Output from the Java application running (or being debugged)
remotely appears in the Workbench’s Console view

» The same launch configuration can be used to debug the Java
application remotely

— Same Java debugger is used for debugging Java applications running
locally or remotely!!!

Problems SRR N Froperties ‘ Tasks ‘ O \ BE & | = E-=06
DECSample [Java Application] C:iProgram Files\IBM| R ational\SDPY6. 0\ecipseljrel bint javaw exe (Sep 14, 2005 11:36:01 AM)

000001 WEESPHERE REDEOOKE 30.00 3GZ4-5635 |
000002 Radio_Controlled Plane 96.86 DELUZE MODEL |
000003 Change Machine 52.55 HAMDLES SEVERAL CURRENCIES

000004 Basshall Tickets 91.14 MIMMESOTL TUWINS

000005 Twelve Mum Two Pencils 50.58 YELLOW IN COLOR o
< i 1 3

why “i"? it's simple.



Program Call Bean Wizard
T ——— Use these controls to add programs / service
Deflne program deflotions for your progeam o procedure programs and all required parameters

/ g

AddProgram... | add Parameter... | add Structurem|/

- 4
L4

Program cal definitians

Edit Program

& || 3avabean name: [eTiTem
Program object: [GETITEM Browse. .,

B3 GETITEM Library: [woscoemo -

"4 PeRTD Program type: [*pam hd
=[9 PARTREC (PARTREC)

&1 Entry paint: [ Browse. .,

[EN[EN

5 NAME CCSID of entry point: [
i ¥ IPRICE -
Return type: void -
& e Ny i— =
|9 FeEDBACK e

Thread safe: [false

|
K
El
Saurce lacation: | =] wiew
oK

Import PCML. .. | Synchronize All |

/

ILE V5R2 compilers can generate PCML directly.

Import the PCML instead of typing all this info! = T o =
I

why “i"? it's simple.

Cancel

On the File->New->Other wizard selection page, select the Program Call Bean
wizard and press Next. In the Program Call wizard, select the program or ILE

procedure to be called from Java. This must be a non-interactive program or
procedure.



Summary of files that
will be generated

© program Call Wizard

Create iSeries Program Call Java bean and PCML file
Specify the location where the Java bean and PCML file are to be generated. 8
Folder: ‘ Sample iSeries Java Source I Wh j Browse...
ere to generate Java class [Eemn |
Package: ‘ com.ibr.iseties. samples j Brawse. ..

PCHL file name: | GETITEM I =

| Where to generate PCML file

Generate Java beans and a PCML file For:

¥ Java application

v services e Select Services to generate Java code optimized for use

in the Web Services wizard

To change parameters later:
®Return to wizard
®Use Import PCML...

button

cancel |

= Back Mext >
why “i"? it's simple.

Here you see that you can confirm where you want the Java code to be
generated, including the Program Call Markup Language (PCML) file that is
also generated.

For the generated Java bean to be used as a Web Service, select the Web
Services checkbox. This generates a Java bean that is easily consumable by
the Web Services wizard. Notice how the wizard will automatically update our
project's classpath to include the necessary AS/400 Toolbox for Java JAR files

so that our
generated code will compile. Finally, press Finish to generate the Java bean!!
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Authentication and
library list settings

© program Call Wizard

Configure Authentication

Please enter the host information

Authentication | Lirary List |

¥ Generate configuration file

Configuration File name: I defaultPCw LI

& Sperify signon values

Host name: |

UserID: |

Password: |

|v Enable password encoding

" Specify the use of JCA connector and JAAS credentials

INDI name: I

<gack | weis [ Al | canel |

y “i"? it’s simple
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Code generated from

© Java - GETITEM.java - IBM Rational Software Development Platform Program Call Bean wizard
Fle Edit Source Refactor MNavigate Search Project Run Window Help
ci - ¥ E [%-0-@-%- 0 G- S| B B e ke
ERE R TR R
|5 Package Explorer 52 Hierarchy | = O || [J] GETITEM.java &2 B8 EHM. =5
=% - I - BR % 0 % v
+[=2 i5eries Web Samples 7 public void initInputi} { @ © GETITEM() ~
+-[E¥ I15PandservietExamplz SELPARTID ("") & GETITEM(String)
=122 Sample iSeries Java Source © . disconnect()
= o, ibr.iseries samples ¥ @ » 0etASH000bjeck()
+- )] GETITEM.java ~ public void EESFN:NE (String PARTID) { @  getFEEDBACKL)
+ :] GETITEMInput. java getValue (_strParentField + ".PARTID", PARTI @ getPARTREC()
#-[J] GETITEMResult.java 3 @ inkInput()
- [J] GETITEMServices.java @ a invoke()
JDECSample.java @ a setConnectionDataAS400)
|+ \J] PARTREC java - public PARTREC_Struct_output getPARTREC() { @ . setConnectionData(String,
= return PARTREC Struct: @ a setCurrentlibrary(String)
|= GETITEM.perml 1 - - @ 4 setInitialCommand(String)
B Ve, geners eh | - public String getFEEDEACK() ¢ - “V.V i
= Bl JRE System Lbrary [eclpse] return (String] getvalue( strrarencriela 4 PsetConnectionData(...)
+- m, iSeries Utilties and Toolbax 3 - . . . .
-, Standard Widget Toolkit (SWT) »to identify signon info
14 WDSC_HOMEpluginsjcom.ibm.etools »setLibraryList(...)
H ) WDSC_HOME/pluginsfcom.ibm. etool: P =10 set runtime lib Jist
= - |
+- g WDSC_HOME/pluginsfcom.ibm,etool: = 8 0 setruntme liorary 1S
1-4g) WOSC_HOME[pluginsjcom.ibm.etook | problems  Javador Declaration | B Console 23 Properties | Tasks »setXXX(...)
1 E*I 162::1;:4 Cl\Pr\ogram Files\BMIRAE | 16 s qmple [ava Application] C:\Progrem Fies\BMiRational|SOPY6. Diedlipseliretbintia »10 set input parameters
Jmipem| .
2] defaultPC.corfig »invoke()
) 12 Sample Java Source »10 run program
»getXXX(...)
10 get output parameters
< | >
cam.ibm.iseries.samples, GETITEM, setPARTID(String PARTID) : void - Sample iSeries Java Source

why “i"? it's simple.

Here we see the result of the Program Call wizard. The selected Java package
in the upper right now contains all the generated Java classes, one of which is
shown in the editor in the middle view. To use the generated Java bean, we
write Java code to instantiate it and call the important methods in it, which are
listed in the information box in the lower left. An example of Java code to use
the bean is shown in the lower middle information box. The pattern for using
the generated bean is this:

1. Instantiate the bean using the New operator

2. Call the setLibraryList method with an array of library names to set up the
library list

3. Call the setXXX methods to set the input parameter data. There will be one
such method for each input parameter.

4. Call the invoke method to call the program or procedure

5. Test the boolean result of invoke for true or false to determine if the invoke
was successful

6. Call the getXXX methods to read the output parameter data that the
program updated. There will be one such method for each output parameter.

49



Agenda

» Getting Started
= The Java Editor
= Visual Editor

= Java Views

Compile / Run / Debug
» iSeries Additions

ﬁ> = Summary and References

why “i"? it's simple.
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| BMesenersees - IEH|
Summary

= Java Development Tools included with Development Studio Client
— Part of IBM Rational Web Developer v6.0
= Java perspective provides optimized view for Java development
— Java Editor + Java Views = Easier Development
— Integrated Compile/Run/Debug
— iSeries Additions for using Java with iSeries
= Lots more
— Team development
— Integrated, online help system
— Extendable platform — you can add your own tools
— Integrated Java, Web, XML, iSeries development

why “i"? it’s simple.
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Resources

= Eclipse
— www.eclipse.org
= WebSphere Development Studio Client
— www.ibm.com/software/awdtools/wdt400/
= WebSphere Developer Domain
— www.ibm.com/websphere/developer
IBM Developer Domain
— www.ibm.com/developer
= Java
— www.java.sun.com

why “i"? it's simple.
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Reference: iSeries JavaBeans
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GUI Beans for iSeries

= Java Beans supplied for DDS-like field error checking and formatting
— JFormattedTextField (smart entry field)

— JFormattedLabel (smart lable constant)
— JFormattedComboBox (smart dropdown)

— JFormattedTable (smart-multi-column list)

why “i"? it's simple.

Included with the iSeries extensions to the Java tools are some GUI and non-GUI Java beans
that can be used in applications developed by WebSphere Development Studio Client
customers. Here you see the GUI beans included with Development Studio Client. These
beans extend their Swing counterparts but add customizations that iSeries developers are
used to with display files such as:

Restricting a value to numeric, string, ...
Specifying the values length and precision
Specifying formatting using edit codes / words

JFormattedTextField

«Error checking based on data type, length, decimals
+DDS-like validity checking: range or comparison
-Editcode or editword formatting and masking
«Auto-advance

JFormattedLabel

Editcode or editword formatting
JFormattedComboBox

«Combo of JFormattedTextField and JFormattedLabels
JFormattedTable

+A subfile or multi-file column list box

«Each cell is a JFormattedTextField or JFormatted Label or JFormattedComboBox
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GUI Beans Examples

*File->New->Other->Examples->iSeries

ormattedTableSample H[=] E3
IternMa Model Size Price

00001 Z000-AB-1 |small ¥ 100 -

000z Z000-AB-2 00, 50
»JFormattedTable 00003 Z000-AB-3 T 69

00004 2000-AB-4 g [il3]

00005 Z000-AB-5  SWall 405

00006 2000-AB-6  =mall 110

00007 Z000-AB-7  |small 230.43

00003 Z0O00-AB-8  medium 268

00003 2000-AB-8  big 732 =

EJEQUITY DRDER ENTRY [_ O] <]
»JFormattedText Symhol: i

Price: ’mT
Account No.: ’@
Password: ’ﬁ
Contact Phone: ’@

why “i"? it's simple.




| EMeseneriseres . IEH|
DFU Beans for iSeries (non-GUI)

= Java Beans supplied for querying data from DB2/400, using direct
record access (versus SQL):

— RecordlOManager
— ListManager

— FormManager

why “i"? it's simple.

Here you see some non-GUI beans that can be used in a Java application to
assist the developer in reading records from and iSeries physical file. The
ListManager retrieves lists of records for display in a GUI list, where as the
FormManager can be used to retrieve a single record for display in a GUI
form.

RecordlOManager
«Query, add, update, or delete records in a database

*Vastly simplifies task of writing database access code using Toolbox for Java
classes

ListManager

*Maps list of records from RecordlOManager to a Swing GUI list
-Makes it easy to populate GUI list with DB2/400 data
FormManager

*Maps details of a single row from RecordlOManager to a single GUI dialog
page
-Makes it easy to populate GUI form with DB2/400 data
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| EMeseneriseres I
DFU Beans Examples

» File->New->Other->Examples->iSeries

»ListManager

ManagerJFormattedTableSample H=1

PARTDIS | PARTSHIP
. AR-10 26.10 29.00 1991-05-10]a

BirormManager with a muitiple record format loical file T EEvE BRI S

AR-12 7.8z 59.00 1554-05-07

g AR-13 11.31 13.00 1351-09-25

AR-1 35.64 36.00 1990-07-07,

LI LR-11 31.15 35.00 1990-01-08

Order Date LR-12 29.92 34.00 1994-03-19

AR-14 39.56 46.00 1993-12-22

Customer Orlor aadaaaa AR-10 24.30 27.00 1994-06-18
AR-11 20.47 23.00 1993-10-13[+|

Gsone btz | readallRecords

ShipVia ot

B
R »FormManager
et




List Beans for iSeries (non-GUI)

= For querying lists of libraries, objects, members, records or fields
— AS400ListLibraries

AS400ListObjects
— AS400ListMembers

AS400ListRecords

AS400ListFields

= Four levels of detail possible per object

= Some OS/400 API wrappers!

why “i"? it's simple.

Here you see some additional non-GUI beans for retrieving lists of libraries,
objects, members, records and fields from an iSeries.

AS400ListLibraries

«List libraries given simple or generic or special name
AS400ListObjects

«List objects given simple or generic library and object name

«Can also subset by type and attribute (one or multi, simple or generic)
AS400ListMembers

List members given simple or generic library, file, member name
«Can also subset by member type (one or multi, simple or generic)
AS400ListRecords

«List records given simple or generic library, file, record name
AS400ListFields

«List fields given simple or generic library, file, record, field name
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References in this document to 1BM products or services do not imply that [BM intends to make them available in every country.

The following terms are or registered of Business Machines Corporation in the United States, other countries, or both:
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why “i"? it's simple.
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why “i"? it's simple.
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